BAB 12

Modul : Grass

GRASS (Geographic Resources Analysis Support System) merupakan perangkat lunak SIG
open source yang memiliki banyak fungsi SIG dan sudah dikenal dengan baik. GRASS dirilis
pertama kali tahun 1984, dan sejak itu mengalami banyak perbaikan dan penambahan fungsi.
QGIS memungkinkan Anda untuk memanfaatkan tool-tool GRASS secara langsung.

12.1 Pelajaran :Pengaturan GRASS

Menggunakan GRASS di QGIS mengharuskan Anda untuk memikirkan antarmuka dengan
cara yang sedikit berbeda. Anda tidak bekerja di QGIS langsung, tetapi bekerja dalam GRASS
melalui QGIS.

Tujuan untuk pelajaran ini: untuk memulai sebuah proyek GRASS di QGIS.

12.1.1 v Ikuti bersama: Mulai Proyek GRASS Baru

Untuk menjalankan GRASS dari dalam QGIS, Anda perlu mengaktifkannya seperti dengan
plugin yang lain.

* Dalam Plugin Manager, aktifkan GRASS yang ada dalam daftar:
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£ QGIS Plugin Manager

Filker

To enable [ disable a plugin, click its checkbox or description

DxfZ2shp Converter

¢ Converks From dxf to shp file Format
Installed in Yector menu,/toolbar

GPS Tools

Tools For lnading and importing GPS data
Installed in ¥ector menu,/toolbar

GRASS

GRASS layver

Installed in Plugins menu,/toolbar

GdalTools {¥ersion 1.2.29)

Inkeqgrate gdal tools into qgis
Installed in Raster menu,/toolbar

Georeferencer GDAL

Genreferencin& rasters using GDAL
Installed in Raster menu,/toolbar

Plugin Directory: C:/0SGe0dW apps/qgis-dew/plugins

Select all Clear all Cancel

Toolbar GRASS akan muncul:

TELIEEEILE

Sebelum Anda dapat menggunakan GRASS, Anda perlu membuat sebuah mapset. GRASS
selalu bekerja dalam lingkungan basis data, yang berarti Anda perlu mengimpor semua data

yang ingin Anda gunakan ke dalam basis data GRASS.

* Untuk memulai, klik tombol New mapset:

¥

Anda akan melihat dialog seperti di bawah, yang menjelaskan struktur dari mapset

GRASS.

* Buat direktori baru bernama grass_ db di folder exercise_data.

* atur sebagai direktori yang akan digunakan oleh GRASS untuk membuat basis data:
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& New Mapset

GRASS Database

Select existing directory ar create a new one:

Datahase: exerrise_datafgrass_dhb Browse, ..

GRASS data are stored Example directory tree:
structure. The GRASS [= QurDatabase Database
database is the top-level b Mexico Lacation 1
directory in this tree PERMAMEMNT Swsbemn mapsek
structure. Alejandra User's mapset

Juan User's mapset

= Mew Zealand Location 2
PERMAMNEMT Swskem mapsek
Cimernan User's mapset
= Back l [ Mext = Cancel

GRASS perlu membuat “lokasi”’, yang menggambarkan luasan maksimum daerah geografis

dimana Anda akan bekerja di dalamanya.

 Sebut lokasi baru tersebut sebagai South_Africa:

12.1. Pelajaran :Pengaturan GRASS
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& New Mapset

GRASS Location

Location

() Select location | v]

® Create new location | South_Africa

The GRASS location is a callection of maps for a particular territory or project.

< Bark Cancel

* Kita akan bekerja dengan WGS 84, jadi cari dan pilih CRS ini:
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& New Mapset

Projection

Coardinake systkem
Mok defined

® Projection

Fiker 4326

Recently used coordinate references systems

Coordinate Reference System

. W3S 54

Autharity ID

EPSG:4326

Coordinate reference systems of the world

Hide deprecated CR9s

|C-:u:urdinate Reference 5ystem

Authaority I0
= @ Geographic Coordinate Systems
Wias 54 EPSG:4526

(<]

+praoj=longlat +daturnm="W3534 +no_defs

< Back Cancel

» Sekarang pilih wilayah South Africa , yang sudah didefinisikan dalam GRASS:

12.1. Pelajaran :Pengaturan GRASS
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& New Mapset

Default GRASS Region

M -21.27
W 13,658 E 33.93
5 -35.9
Set current QGIS extent | | | South Africa - Sak

The GRASS region defines awarkspace for raster maodules. The default region is valid
for one location. [tis possible to set a different region in each mapset. tis possible to
change the default location region later,

< Back Mext = Cancel

* Buat mapset, yang merupakan file peta yang akan Anda kerjakan.

302

Bab 12. Modul : Grass



Quantum GIS Training Manual, Rilis 1.0

& New Mapset

Mapset

Mew mapset: |grass_mapset| J

The GRASS mapsetis a collection of maps used by one User Auser can read maps
from all mapsets in the location but he can open forwriting only his mapset (owned by
user.

Setelah Anda selesai, Anda akan melihat kotak dialog yang meminta Anda untuk mengkonfir-
masi bahwa pengaturan tampilan ini sudah benar.

o Klik Finish.

* kemudian klik OK pada dialog sukses.

12.1.2 e Ikuti bersama : Memuat Data Vektor ke dalam GRASS

Sekarang Anda akan memiliki peta kosong. Untuk memuat data ke dalam GRASS, Anda perlu
mengikuti proses dua langkah.

* Pertama, muat data ke QGIS seperti biasa.  Untuk saat ini gunakan dataset
streets.shp (temukan di dalam folder exercise_data/).

» Segera setelah data tersebut dimuat, klik tombol GRASS Tools:
N
e Temukan fool untuk mengimpor vektor dengan memasukkan ... berikut:

v.in.ogr.qggis dalam pilihan Filter dari kotak dialog yang muncul.

v merupakan singkatan dari “vector”, in merupakan fungsi untuk mengimpor data ke dalam
basis data GRASS, ogr merupakan library perangkat lunak yang digunakan untuk membaca
data vektor, dan ggis merupakan fool untuk melihat data vektor diantara data vektor yang
telah disimpan dalam QGIS.

* Setelah menemukan tool ini, klik pada fool tersebut sehingga akan muncul:
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& GRASS Tools: South_Africalgrass_mapset

Modules Tree Madules Lisk Braowser P B

Madule: w.in.ogr.qgis

Options Oukpuk Manual |

Loaded layer

Select a laver -

Passward

Mame for oukput veckor map

L«]]

Run Wiew outpuk Close

Close

* Atur layer yang dimuat ke dalam streets dan ubah nama file versi GRASS menjadi
:kbd:‘g_streets‘s untuk menghindari kebingungan.
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& GRASS Tools: South_Africalgrass_mapset

Modules Tree Modules Lisk Browiser B

Module: vv.in.ogr.gois

Options Cukput Manual

Loaded layer

streets -

Passward

[ ]

Mame For output weckar map o~

I g_streets I

Fun Wigw outpuk Close

Catatan: & Note the extra import options provided under Advanced Options. These inclu-
de the ability to add a WHERE clause for the SQL query used for importing the data.

Klik Run untuk memulai import.

Setelah selesai, klik tombol View output untuk melihat layer GRASS yang baru diimpor
ke dalam peta.

Tutup terlebih dahulu import fool tersebut (klik tombol Close di sebelah kanan View
output), kemudian tutup jendela GDAL Tools.

Hapus layer awal roads_33S.

Sekarang yang tersisa hanya layer GRASS yang telah diimpor seperti yang ditampilkan dalam
peta QGIS Anda.

12.1.
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12.1.3 . 4 Ikuti bersama: Memuat Data Raster ke dalam GRASS

DEM yang kita gunakan memiliki sistem proyeksi CRS UTM 335 / WGS 84, sedangkan
projek GRASS kita menggunakan sistem proyeksi Geographic CRS WGS 84. Jadi mari kita
lakukan proyeksi ulang DEM terlebih dahulu.

e Muat dataset srtm_41 19.tif (data disimpan dalam folder
exercise_data/raster/SRTM/) ke dalam peta QGIS seperti biasa, meng-
gunakan tool Add Raster Layer.

» Lakukan proyeksi ulang menggunakan tool GDAL Warp (Raster — Projections — Warp
(Reproject)). Cara pengaturannya ditunjukkan dalam kotak dialog berikut:
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& Warp (Reproject)

Batch mode (For processing whole directory)
Input File srtmn_41_19.kF | = Select. ..

iokput File TM/DEM W358, kf Select. ..
X Source SRS EP9i3: 327373 Select. ..

X Target SRS EPSGI4326 Select...

X Resanmpling method Mear

Mo data walues [D ]

Mask laver [ "]| Select, .. |

Mernory used For caching [EDMEI

Resize

width | 3000 = Height | 3000

Use multithreaded warping implementation

®| Load inko canvas when Finished

* Simpan data raster di dalam folder yang sama seperti aslinya, tetapi dengan nama file
DEM_WGS84.tif. Setelah muncul di peta, hapus dataset srtm_41_19.tif dari
Layers list Anda.

Sekarang lakukan proyeksi ulang, anda dapat memuat ke dalam basis data GRASS Anda.
* Buka kotak dialog GRASS Tools lagi.
» Klik pada tab Modules List .
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e Carir.in.gdal.qggis:

& GRASS Tools: South_Africalgrass_mapset

Modules Tree Modules Lisk Browser |

Filter | r.in.gdal qgis

) 5 Ve rin.gdal.qgis.loc
h - \3{

Import loaded raster and create a fitked location

rin.gdal.ggis

Impart Inaded raster

':{} _'I\ rin.gdal.qgis
\3’ Import loaded raster
(%) ‘:D’ <"> r.in.gdal,qqis.loc

Import loaded raster and create a fitbed location

Close

Yang memberi Anda tool ini:
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& GRASS Tools: South_Africalgrass_mapset

Modules Tree Modules Lisk Browiser ¥ =y

Module: rin.gdal, qois
Options Cukput Manual

Loaded layer

Select a layer -

Passward

Mame For outpuk raster map o~

-

g_dem

Fun Wigw outpuk Close

Close

Lakukan pengaturan seperti ditunjukkan (layer input DEM_WGS84, hasilnya g_dem).
Klik Run.

Ketika proses selesai, klik View output.

Selanjutnya Close tab saat ini dan Close kotak dialog keseluruhan .

Lavetz
= Eﬁ_ g_streets

x -ég_dem

| Control rendering order
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» Sekarang Anda dapat menghapus layer awal DEM_WGSS84.

12.1.4 Kesimpulan

Alur kerja GRASS untuk mengolah data agak berbeda dari metode QGIS, karena GRASS me-
muat data ke dalam struktur basis data spasial. Namun, dengan menggunakan QGIS sebagai
antar muka, Anda dapat membuat pengaturan dari mapset GRASS lebih mudah dengan meng-
gunakan layer yang ada di QGIS sebagai sumber data untuk GRASS.

12.1.5 Apa Selanjutnya?

Sekarang data yang diimpor ke dalam GRASS, kita dapat melihat operasi analisis tingkat lanjut
yang disediakan oleh GRASS.

12.2 Pelajaran: Tool- Tool GRASS

Dalam pelajaran ini kita akan menyajikan pilihan fool untuk memberikan gambaran tentang
kemampuan GRASS.

1221 ¥ Ikuti bersama: Mengatur Warna Raster

* Buka kotak dialog GRASS Tools .
e Carimodul r.colors.table di kolom Filter dari tab Modules List.

* Buka ool tersebut dan atur sebagai berikut:

Marne of input raster map

q_dem { g_derm@qgrass_mapsek ) - ]:[
Type of color kable
Color paletke For Shuttle Radar Topography Mission elewation -

Ketika Anda menjalankan fool ini, tool ini akan mewarnai kembali peta raster Anda:
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12.2.2 ‘ Ikuti bersama : Visualisasi Data dalam 3D

GRASS dapat digunakan untuk memvisualisasikan data DEM Anda dalam tiga dimensi. Tool
yang akan Anda gunakan untuk beroperasi pada Daerah GRASS, yang saat ini diatur ke seluruh
Afrika Selatan, sebagaimana telah Anda tetapkan diatas sebelumnya.

* Untuk mendefinisikan kembali cakupan dataset raster, klik tombol ini:

[y

Ketika rool ini diaktifkan, kursor anda akan berubah menjadi tanda silang ketika digerakkan di
atas peta QGIS.

* Dengan menggunakan fool ini, buatlah kotak persegi panjang sekitar tepi raster GRASS

* Klik OK pada kotak dialog GRASS Region Settings ketika telah selesai.

e Caritool nviz:
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€. GRASS Tools: South_Africa/grass_mapset

Modules Tree Modules List Browser

Filter = iz
nviz
B aD-Yiewer (NYIZ)

Close

* Atur seperti yang ditunjukkan berikut:

Mame of raster mapis) for Elevation

g_dem { g_demi@grass_mapsek ) *

Mame of raster mapis) for Color

Mame of vector lines/areas overlay map(s)

g_skreets [ g_streetsi@grass_mapset 1 ling ) -

* Jangan lupa untuk mengaktifkan kedua tombol Use region of this map di bagian kanan
dari menu pilihan raster. Hal ini akan memungkinkan NVIZ untuk menilai resolusi raster
secara benar.

¢ Klik tombol Run.

NVIZ akan membuat gambaran 3D menggunakan data raster dan vektor terpilih. Proses ini
mungkin membutuhkan waktu yang lama, tergantung pada spesifikasi perangkat keras yang
digunakan. Ketika selesai, Anda akan melihat peta ditampilkan dalam 3D di jendela baru:
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NVIZ ==

File Appearance VYisualize Seripting Help

DRAWN | Clear | Cangel |

Automatically render display:

Show features:  dain features —l‘ Decorations. —l|

View method: % eye € center € fiynone —

here
center
top
reset

he\gm b exag
38544 U oooc

perspectwe 40.0 twwsl 0

4

Cobalah untuk melakukan pengaturan height, z-exag, dan View method untuk melihat data dari
sudut pandang yang lain. Anda membutuhkan waktu yang cukup untuk terbiasa dengan metode
navigasi yang digunakan.

12.2.3 - Ikuti bersama:Perangkat Mapcalc

* Buka kotak dialog GRASS Tools tab Modules List dialog dan cari calc.
» Dari Module list , pilih rmapcalc (jangan sampai keliru dengan rmapcalculator).
* Jalankan fool ini .

Dialog Mapcalc memungkinkan Anda untuk menjalankan analisis yang berurutan pada peta
raster, atau sekumpulan peta raster. Anda akan menggunakan tool ini untuk melakukannya:

R A N N

Tool-tool yang akan digunakan adalah:

* Add map: menambahkan file raster dari mapset GRASS Anda saat ini.

* Add constant wvalue:menambahkan nilai konstan yang akan digunakan dalam
fungsi.

* Add operator or function: menambahkan operator atau fungsi untuk dihu-
bungkan ke masukan dan keluaran.

* Add connection: menghubungkan elemen-elemen. Dengan menggunakan tool ini,
klik dan seret dari titik merah pada salah satu item ke titik merah pada item lain. Titik-
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titik yang terhubung secara benar ke saluran konektor, akan berubah abu-abu. Jika garis
atau titik berwarna merah, berarti titik-titik tersebut tidak terhubung dengan benar!

* Select item:Memilihitem dan memindahkan item yang dipilih.

* Delete selected item: Menghapus item yang dipilih dari lembar mapcalc saat
ini, tetapi bukan dari mapset (jika itu adalah raster yang ada).

Dengan menggunakan fool ini:
* buatlah algoritma berikut:

Madule: r.mapcalc

Options Qutput Mariual

.5
U|E
.
g
£l
Ty
ks

Cukput | alkitude_range

» Ketika Anda mengklik Run, hasil yang diperoleh seharusnya terlihat seperti berikut:

r.mapcalc "altitude_range = {{{g_dem@grass_mapset <500} | | {g_dem@grass_mapset =1000)))"
Successfully finished

* Klik View output untuk melihat hasil operasi ditampilkan dalam peta:
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ol W

Hasil ini menunjukkan semua area yang memiliki ketinggian kurang dari dari 500 meter atau
lebih dari 1000 meter.

12.2.4 Kesimpulan

Dalam pelajaran ini, kita hanya membahas beberapa tool yang disediakan GRASS. Untuk
mengeksplorasi sendiri kemampuan GRASS, buka dialog GRASS Tools dan cari Modules List.
Cara yang lain, lihat di bawah tab Modules Tree, yang mangatur tool sesuai dengan jenisnya.
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